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Change Log 2011

OpenCPN Version 2.5.0

Released 27 July 2011
OpenCPN Version 2.5.0 is released, and available for immediate download.
The version is a major feature upgrade and maintenance release of OpenCPN.

OpenCPN is a free and OpenSource navigation package running on Windows, linux, and Macintosh
computers.

New and Enhanced Features for OpenCPN Version 2.5.0

1. Per-Cell offset adjustment for cm93 charts.
2. Transverse Mercator chart quilting.
3. Selectable full screen quilting option.
4. Configurable lat/lon grid lines.
5. Variable screen dimmer function.
6. Improved Tide/Current information window.
7. Configurable “Layers” function, enabling selectable display of fixed objects.
8. Improved and extended AIS functions, including
a. Euro Inland support
b. Base Stations and ATONs
9. Selectable Full Screen display mode.
10. Integrated Route Planner function, with Tide table support.
11. Enhanced GUI functions, with floating transparent Toolbar.
12. Several new language options.
13. Improved internal memory management.
14. Improved Autopilot output support.
15. New Multi-leg Measurement tool.
16. Improved Vector chart symbology.
17. Improved integrated Tide/Current data accuracy.
18. Improved Route definition interface, including selectable Route colors.
19. Full conformance for all platforms, especially including Macintosh OS X.
20. Greatly improved stability on all platforms, as a result of extended Beta testing.
21. Many, many improvements in the basic User Interface, while maintaining the

   ease-of-use that OpenCPN is widely known for.\\

Plugins:
1. Enhanced Dashboard Plugin with several new instruments.
2. Enhanced GRIB Plugin with isobar graphic depiction.
3. Extended Plugin interface definition allowing greatly increased Plugin functionality.
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We hope you enjoy the new features of OpenCPN Version 2.5, and look forward to your continued
feedback.

Download OpenCPN Version 2.5.0 at
http://sourceforge.net/projects/opencpn

For Plugins and other useful information, visit our support website at
http://opencpn.org

The OpenCPN Development Team
Dave Register, Lead Developer

OpenCPN Version 2.3.1

Released 01 January 2011
OpenCPN version 2.3.1 is a maintenance release enhancing version 2.3.0
sourceforge/projects/opencpn

OpenCPN Version 2.2 Beta Build 1211 is now available.

Changelog

221. Improve performance of AIS Target List Dialog.
222. Correct double chart dir entries in Toolbox→Charts (FS#288)
223. Update S52 symbolization regarding Topmarks. Thanks again, Nohal….
224. Add a few more strings to .pot file. (FS#287, FS#298)
225. Disable ability to delete MOB point via context menu. (FS#278 redux)
226. Correct point visibility attribute of imported GPX tracks. (FS#253 again)
227. Update some existing translations, add Finnish and Greek.
228. Improve Lat/Lon input string parsing. (FS#286)

Release Beta 1211

Is this the final Beta ? I think so….

Please check your Flyspray Tasks. I would like to see the list get down to “deferred” issues only for
release. These deferred issues will then be moved to the 2.4 Beta program, whenever we are ready to
start that process.

Thanks
Dave

Hello Testers….

http://sourceforge.net/projects/opencpn
http://opencpn.org/
http://sourceforge.net/projects/opencpn/
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Here is the BSB4 PlugIn , Beta version 0.1

Installation:
1. Download and install OpenCPN Beta Version 2.4.0310 or later. This Build will be available shortly.
Watch the opencpn.org Download page.

2. Download the PlugIn file bsb4_pi.doc which is attached to this post. Rename the file to
bsb4_pi.dll.Copy the dll into the OpenCPN plugin directory, typically C:\Program Files\OpenCPN\plugins.
You will see the other standard OpenCPN PlugIns in this directory already.

(Note to admins: Why cannot we upload/attach .dll files? The restriction is only an inconvenience to good
citizens, not an effective prohibition…)

Operation:
1. Start OpenCPN
2. Open the Toolbox→Plugins tab, and enable the BSB4 PlugIn.
3. Open the Toolbox→Charts tab. Navigate to and select a directory containing BSB4 charts. Add this
directory, and close as normal.
4. Installed BSB4 charts will be available in to chart bar.

Notes:
1. This Beta version produces a lot of log file output, as an assist to debugging. Much of the output will go
away on production release.
2. I have tested this PlugIn on the two BSB4 portfolios I own, both Canadian CHS issue, with no problems.
3. If problems are encountered, please cut, paste, and upload the most recent logfile entries for
diagnosis.

Good Luck
Dave

Ahoy OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 310 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog:

1. Implement support for BSB Version 1 Polyconic projection charts.(FS#326)
2. Implement cm93 “per-cell coverage” offset adjustment dialog.
3. Implement Transverse Mercator (TMerc) quilting. (FS#315)
4. Implement Full screen quilting mode, Toolbox selectable.
5. Implement Blit accelerated chart panning.
6. Improve overzoomed quilt patch registration and georeferencing.
7. Correct some Route and Waypoint navobj regression errors. (FS#244, 324, 327, 343, and 349) Thanks
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for the patch,Pavel.
8. Implement configurable Lat/Lon grid lines. Thanks for the patch, Carsten.
9. Correct detection of some BSB charts in UTM projection (FS#325)
10. Implement Multi-Dashboard support. (FS#289) Thanks Sethdart
11. Improve Dashboard NMEA messsage parsing for Wind and Heading instruments (FS#276) Sethdart
12. Add additional translatable strings to AIS message parser. (FS#351) Thanks again Sethdart
13. Various language updates (ET)
14. Implement PlugIn API Version 104

Release Beta Version 2.4.310

Notes:

2. CM93 “per cell” offset dialog.
Background:
Each cm93 cell contains one or more MCOVR objects, describing the datum and possible offsets which
apply to objects within the boundaries of that MCOVR region. What is new here is that we have
implemented programmable “user offsets” for each MCOVR object as well, so that individual coverage
regions may be fine tuned by users so that they may better align with observed georgraphy or other
(presumably more accurate) charts. User offsets will apply only to the MCOVR region(s) selected, and not
to the entire folio of cm93 charts as is done in Version 2.3.1.

Here is how to use this feature.
1. Go to single chart (i.e. non-quilted) mode, with cm93 charts displayed.
2. Zoom/Pan to the region of interest.
3. Right click, activate “CM93 Offset Dialog”
4. In the list of cells/MCOVR IDs, selected the one MCOVR of interest. The coverage area for this MCOVR
object will be outlined
with a heavy yellow border.
5. Use the spin controls on the right side of the dialog to adjust the desired user offsets.
6. The offsets are automatically saved in the binary MCOVR cache files found in the program data
directory as CM93/…

In order to use this feature effectively, one needs a geographically known reference point. As an
example, say there is a NAVAID present on the chart cell with known wgs84 lat/lon, as from a light list. In
this case, one can drop a waypoint on the chart, edit the waypoint properties to the known lat/lon, and
then use the CM93 Offset Dialog to slew the cell/MCOVR so that the dropped waypoint coincides with the
NAVAID feature on the cm93 cell (chart).

You may also use a geographical feature such as a cape or point whose location is absolutely known, as
by reference to observation, or by rendering on another, more accurate chart such as a trusted scanned
raster chart or georeferenced photo chart.

3. TMerc charts are quilted with other TMerc charts. This should work well in areas (e.g. Sweden) where
there are multiple overlapping
North-up TMerc charts. It will not work in South Pacific, where there seem to be isolated (NZ?) TMerc
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charts.

4. By request, we allow more charts on the viewport to be added to the quilt. We add charts of an
appropriate scale range to the quilt, even if they do not overlap with the center of the screen. Of course,
this will cause some performance issues for some locations and some systems. So, it is configurable in
Toolbox.

14. PlugIn API Version 104: This will be transparent, but will enable the BSB4 and other PlugIns coming
soon.

Good Luck testing, and keep those Flyspray tasks coming.
Don't forget to update “your” Flyspray tasks with with test results. That way we can close the tasks as
appropriate.

Sorry about the temporary un-availability of the Windows installer. Should be uploaded soon.

Thanks
Dave

wxWidgets 2.9

Hello folks….

Background:
1. the MAC OSX build of OCPN needs to use wxWidgets 2.9 in order to get around some serious
implementation bugs in wxWidgets 2.8. Thanks to the Mac team for working this out.
2. The current source tree for OCPN has been compiled and minimally tested in wxWidgets 2.9. The few
problems seen so far appear tractable.

The Rub:
1. wxWidgets 2.9 is not available as precompiled libraries for any current linux distribution. We don't
know when this will happen officially. For example, I doubt the next release of Ubuntu will include 2.9. I
expect it will not be until 2012 that we see widespread availability of wxWidgets 2.9/3.0.
But I could be misled here…

I think it is important to maintain a single code base for our three platforms. So this is the situation on
each:

a. Windows: No problem, since the Windows installer includes and installs the required wxWidgets
libraries. We can migrate to 2.9 whenever we like.

b. Mac: Ditto. The .dmg includes the compiled wxWidgets libraries. Currently Beta testing with wxWidgets
2.9

c. linux: Well, we could do the same as the other two distros, namely package wxWidgets 2.9 as part of
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OCPN debian package. But this is not thought to generally be a good idea, since it can lead to duplication
of libraries, user inconsistencies, etc. The debian package reviewers will probably not sign off on this.
Further, we cannot statically link against a precompiled wxWidgets 2.9 library set, since we require
dynamic library loading to support PlugIns.

Thus, a quandary…..

If we can find a solution, I would like to migrate OCPN to wxWidgets 2.9 for the official 2.5 release of
OCPN in June.

So, I invite comments and opinions on this subject. Especially, those who really understand debian
packaging (AntonM?) will have ideas, and possibly workable alternatives to the brier patch we face.

Thanks
Dave

OpenCPN Version 2.4 Beta Build 324 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog:

15. Correct M_COVR logic for cm93 subcells.(FS#308)
16. Correct crash on zoom with no charts visible (FS#374)
17. Correct quilt composition for partial screen pans. (FS#375)
18. Correct for excessive range → very small scale → crash on zoomout of cm93.
19. Correct Polyconic quilting logic, especially apparent on NOAA Great Lakes BSB Raster.
20. Correct error logic on startup with empty config file and existing chart database.
21. Correct AIS display of vessels “Not Under Command”, with invalid COG and SOG (FS#354)
22. Correct AIS CPA logic for COG reported 360.0 (COG unavailable) (FS#337)
23. Correct AIS Target List Display with no ownship position available (FS#334) Thanks, Marco…
24. Refine logic for waypoint delete/remove on currently active route (FS#348)
25. Correct Unicode problem with creation of some SENC files. (FS#346)
26. Further optimize Track rendering (FS#368)
27. Enhance coordinate entry method to allow Unicode “degree” and alternate “minutes” signs (FS#322)
28. Arrange to send position fix to all PlugIns on successful NMEA message parse. (FS#387)
29. Integrate Route/Track splitting and extending patch. Thanks Piotr.
30. Implement experimental screen dimmer. Try Function key F6.

Notes:

30. Dimmer works on Windows only, and may not work for all versions. Feedback needed.

I have a suspicion that I may yet be missing one or more patches that were submitted during my

http://www.cruisersforum.com/forums/tags/opencpn.html
http://www.cruisersforum.com/forums/tags/opencpn.html
http://www.cruisersforum.com/forums/tags/bsb.html
http://www.cruisersforum.com/forums/tags/ais.html
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absence.
I had patches to integrate coming out my ears. Some were conflicting, and required “touchup”.

If your work is missing or broken from this Beta , let me know and send me a clean patch against this
Beta , please.
I'll integrate for the next Beta .

Good Luck
Dave

Ahoy OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 412 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog
31. Correct cm93 quilt rendering errors when mouse dragging and clicking.
32. Improve useability of cm93offset dialog.(FS#308)
33. Ignore wgsox/y embedded offsets in cm93 database, while preserving user offset capability.(FS#393)
34. Correct vector chart rendering of soundings drawn very near screen edge. (FS#???)
35. Correct calculation and rendering of Lat/Lon grid.(FS#391)
26. Correct logic for chart database update requirement. (FS#370)
27. Correct AIS ROTIND = +/-127 target query report. (FS#388)
28. Implement improved chart quilt-patch highlighting. (FS#395) Thanks Will.
29. Improve S57 ENC behavior in Full Screen Quilting mode. (FS#397) Thanks to Will for Youtube demo.
30. Implement “esc” key for route creation end in addition to context menu “End Route”. Thanks
HappySeagull
31. Integrate Enhanced Tide/Current Info patch. Thanks jp. (FS#128)
32. Integrate Automatic Daily Tracking patch (FS#???) Thanks piotr
33. Integrate Version 2 of RouteManagerDialog Layers Tab. Thanks, piotr.
34. Correct off screen object move logic. (FS#347)
35. Implement AIS ATON decoding and reporting. (FS#340) Thanks piotr
36. Improve implementation of Screen Brightness (F6) function.
37. Implement “Full Screen” toggle (F10)
38. Improve Quilt logic for large scale range quilt. (FS#316)
39. Implement persistent quilting algorithm. (FS#398) Thanks Will, for the idea.
40. Implement “confirm” dialog for track delete from context menu.
41. Implement enhanced RoutePlanner function, thanks to piotr, again….
42. Accept header parameter “PR=TM” for TMerc BSB charts, as well as “PR=UTM”.
43. Implement AIS Inland binary broadcast, DAC 200 FI 10, especially UN Ship Type (FS#385).
44. Correct behavior of AIS target list rangle limit spin control (FS#355)
45. Correct AIS target list sorting limits. Sorting disabled with more than 1000 targets. (FS#339)
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47. Correct rendering of some vector chart features, especially isolated small rocks and depth contours.
(FS#373)
48. Save and Restore “Ships Bells” state.
49. Correct symbolization of Moored and Anchored AIS targets. (FS#389)
50. Improve chart info window rollover formatting (FS#249)
50. Change Grid legend color to light grey.
51. Various language file updates.
52. Modify plugins/ CMakeLists.txt to streamline plugin building. Thanks to Jean-Eudes for the idea.

Release Beta Version 2.4.412

Notes:

31. This is neat. A big thanks to JP for the programming effort. Lots of fiddly stuff required here.
Applause…..

33. I'm just coming up to speed on the Layers function. Integrated as received. Feedback appreciated.

36/37. Highly platform dependent. Probably not right yet for non-Windows platforms. Fussy….

40. Suggestion from down under. Good idea. Tracks are valuable and potentially irreplacable….

47. This one will be important. You will note the enforced symbolization of Safety Depth contour (or
nearest greater contour, depending on the contours available in the ENC) in all Display Categories. Also,
UWTROC is always symbolized if dangerous with respect to safety depth and attributes.

51. Languages: I updated what I have received recently. I am not making a great effort to keep .po and
.pot files up to date until we get a little closer to release of Version 2.5.xxxx

Good Luck
Dave

Ahoy OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 423 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog
53. Improve Route drag/draw performance.
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54. Correct grid drawing logic for skewed/rotated viewports.
55. On route create by mouse, hide routepoint names on created points.
56. Correct memory leak symbolizing cm93 and S57 ENCs. Thanks, Pavel…
57. Correct crash on S57/cm93 after Toolbox access (LUP = NULL)(FS#414, FS#419)
58. Correct Inland AIS decode of UN vessel type 8440 (FS#385)
59. Correct cm93 quilting at Greenwich crossing (FS#411)
60. Correct Fullscreen mode logic, F11. (FS#404) Thanks to Pavel
61. Remove “Ghost” tab on Windows taskbar (FS#408)
62. Correct again the case of dragging routepoint out of canvas window. (FS#347)
63. Correct Object Query logic for cm93 quilted mode.
64. Correct vector chart object rendering after dragging small pixel moves. (FS#394)
65. Render “About” dialog in dusk/night colours (FS#231)
66. Correct quilting persistence startup case (FS#413)
67. Improve Tide bar graphics (FS#128) Thanks again, jp.
68. Correct some tidal station TZ offsets, especially NZ. Thanks, Thomas

Release Beta Version 2.4.423

Notes:
55. This is a performance tweak. Big improvement in routepoint drag perfromance.
57. Sorry about this one. I know this bug made 412 just about unusable with vector charts…

Coming next:
Manimaul's floating, translucent, dockable, rotatable toolbar.

Special Requests:
1. Please check your Flyspray tasks. My goal is to get them CLOSED and GONE…Please help me out on
this if you have time.
2. If you are building and submitting patches, please adjust your text editor for “tabs-as-spaces”, tab-
stop=6. This makes my code integration much easier, and helps keep the source “tidy”.

Good Luck
Dave

ello XP crashers….

OK, time to do a little Windows crash dump debugging….

For those Windows XP users who have a semi-repeatable crash scenario, we can get some useful
information regarding the stat of the sytem at crash time by doing the following.

Procedure:

0. Download a special debug version of opencpn.exe http:opencpn.de/sites/default/file…mp/opencpn.exe
hosting provided by Gunther (Netsurfer) Thanks.

1. Verify that drwtsn32.exe is available. Description of the Dr. Watson for Windows (Drwtsn32.exe) Tool

http://opencpn.de/sites/default/files/downloads/windows/temp/opencpn.exe
http://opencpn.de/sites/default/files/downloads/windows/temp/opencpn.exe
http://support.microsoft.com/default.aspx?scid=kb;EN-US;308538
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2. Configure drwtsn32.exe Start→Run drwtsn32
Set “Crash Dump Type” to “Full”
Take note of “Crash Dump” text entry box. This is where the crash dump will be stored. We need that
later.
Also note that drwtsn32 is sticky, and will automatically be loaded at each reboot, providing a “just in
time” debugger to catch application faults of many types. Non-intrusive otherwise.
3. Run OpenCPN, make it crash. Say “OK” to all crash report dialogs, except “Don't Send” to Microsoft 
4. Get windbg.exe from Microsoft Debugging Tools for Windows 32-bit Version.
5. Run windbg
File→Open Crash Dump
Navigate to the crash dump save location recorded in Step 2 above, and open the dump file, generally
called “ user.dmp “
Churn, churn…. ignore warnings.
When able, do Windbg menu View→Call Stack

If you have downloaded the opencpn source files from sourceforge git repository, we can get even more
information.
in Windbg, Set File→SourceFilePath to the ….\src directory of the opencpn source code tree.
You will see a bit of an OpenCPN source code file, with crash location highlighted. This is what we need to
know.

6. Take a screenshot.
7. Post here, or send to me.

Thanks for the extra effort
Dave ====== ====== Ahoy OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 506 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog
69. Correct AIS BlueFlag decoding (FS#433)
70. Correct AIS decoding of targets with invalid parameters (FS#424)
71. Correct some errors in AIS target reporting (FS#425)
72. Correct AIS target list sorting and Range display. (FS#430)
73. Shift ScaleBar to right when grid is displayed. (FS#409)
74. Correct rendering of rotated/greyed user defined ownship icon. (FS#422 FS#423)
75. Correct some README file names/locations.
76. Correct raster chart rendering on extreme overzoom. (FS#428)
77. Correct text buffer overrun problem on vector charts seen on some AMD-64 systems.
78. Correct cm93 quilted line object “smearing” at some locations and scales.
79. Correct auto-pan on route create.

http://msdn.microsoft.com/en-us/windows/hardware/gg463016
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80. Correct active track rendering at very large scale.
81. Correct logic for chart stacks larger than 30 charts. (FS#316)
82. Implement new floating transparent toolbar. Thanks to Will (Manimaul) for the ideas.
83. Redesign right click context menu layout (FS#256)
84. Various CMake and PlugIn patches, thanks to Jean-Eudes.
85. Add shift key direction flip control to F6 dimmer.
86. Correct positioning of long rollover strings (FS#299)
87. Correct AIS target timeout logic (FS#338)
88. Add Traditional Chinese language support

Release Beta Version 2.4.506

Notes:

82. This is new. Note the “grabber” symbol at the far right side of the toolbar. Use this handle to drag the
toolbar wherever you want it.
It “snaps” to the edges. Right click on the grabber, and the toolbar shifts to vertical format. On Windows
(at least), the toolbar dims down transparently until you roll over it. Have fun….

85. Shift key with F6 reverses dimming direction, allowing easier control. Find just the level you want.

Other notes:
No good results or feedback have been obtained from intermittent crashes on cm93 quilted pans.
Please test this aggressively, but in simple and easily reproduced scenarios if possible.

There are some language file updates for this Beta version.
With luck, we will get all the .po files updates for the next Beta . Keep them coming…

Thanks, and Good Luck
Dave ====== ====== Ahoy OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 523 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog:

89. Implement fine scale vector chart zoom in/out by CTRL+ and CTRL-
90. Improve toolbar positioning alogrithms (FS#441, FS#446))
91. Correct toolbar mouse event memory leak Thanks, Pavel
92. Improve current station parsing and rendering. Thanks Thomas
93. Correct occasional partial “red” rendering of cm93 area objects.
94. Correct cm93 rendering with autofollow on at low speed (FS#449)(FS#470)
95. Correctly clean include/version.h (FS#443)
96. Implement F6 dimmer for linux.
97. Correct Blue Paddle for AIS Base stations (FS#453)
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98. Correctly show ATON name in AIS target list. (FS#447)
99. Correctly handle VDO messages in AIS stream. (FS#448)
100. Improve COG report on AIS target rollover (FS#425)
101. Implement selectable toolbar transparency at Toolbox→Etc.
102. Improve responsiveness of zooming quilted ENCs under Windows (FS#454)
103. Re-enable tide/current master station constituent cacheing in station_mru.dat
104. Remove unuseable entries from tide/current HARMONICS.IDX
105. Correct occasional crash on chart drag ab initio. (FS#405)
106. Increment PlugIn API version to 1.5
107. Correct occasional crash with cm93OffsetDialog open on program close. (FS#440)
108. Correct certain overzoom cm93 quilt scenarios (FS#461)
109. Refine F9 quilt toggle logic (FS#455)
110. Improve AIS AtoN data reporting. (FS#467)(FS#465)
111. Refactor source and build tree to enable build options like “cmake -DUSE_S57=OFF ..” (FS#437)
112. Implement improved lat/lon parser (FS#462) Thanks Pavel
113. Considered and rejected (FS#331), AIS Buddies patch. Should be a PlugIn….
114. Correct typo error on AIS Ship type (FS#472)
115. Correct some memory leaks on S57 ENC ingest. (FS#476) Thanks, Gunther
116. Implement improved lat/lon display patch (FS#468) Thanks Pavel
117. Apply patch to allow user selectable colours for routes and tracks (FS#445), again Pavel 
118. Implement new “Wheel-Zoom-to-Cursor” algorithm.
119. Correct AIS CPA logic for ownship COG undefined (FS#458)
120. Correct toolbar toggle states update (FS#485)
121. Implement full translation of AIS target information (FS#480)
122. Rework CMake script for Grib PlugIn to use system BZip2 libraries on linux.
123. Implement AIS AtoN Extended name decoding (FS#466)
124. Prevent “Jump To” AIS targets in target list with invalid positions. (FS#464)
125. Refine AIS report format, removing “Recent Report Period” (FS#487)
126. Ensure ownship is drawn atop close AIS targets. (FS#431)

Release Beta Version 2.4.523

Notes:
96. F6 dimmer support for linux uses xcalib utility.
Sorry about the flashing on increase of brightness.
This is due to the limited set of xcalib command line options.
Correct solution will require porting the guts of xcalib into OCPN.
Another day….
101. Also, please note that on linux, if you want transparent effects on the toolbar
then you must install and enable some form of window manager compositing system.
106. All PlugIns will need to be rebuilt against the 1.5 API.
There is no functional change, just a version uptick for proper load verification.
113. Here is an opportunity for a PlugIn developer….
118. Latest iteration on WZTC. Try it….

Special thanks this time to Marco, for all his AIS exercising.
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The AIS module is becoming pretty capable, thanks to his assistance (and persistence).

I also append the BSB4 Plugin, rebuilt for API 1.5.

Thanks, and Good Luck
Dave ====== ====== Ahoy OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 606 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog:
127. Correct AIS Range/Brg calculations (FS#424)(FS#430)
128. Correct AIS target rollover graphics (FS#496)
129. Correct AIS transponder VDO position report logic (FS#495)
130. Correct AIS target list sorting. (FS#494)
131. Correct AIS ATON size report. (FS#492)
132. Improve “About” dialog color scheme (FS#474)
133. Correct fault on some incorrectly coded ENCs causing crash on exit. (FS#469)
134. Improve LatLon parser and LatLon display formatting. Thanks Pavel
135. Correct fault on transient or nonexistent GPS com port detection. (FS#508)
136. Improve RouteProperties Timestamp display.
137. Allow option RMC message to Autopilot output stream. [Settings]AutoPilot NMEA Sentence
Out=RMC;RMB
138. Refine AIS target report for ClassB targets (FS#505)
139. Correct ownship calcualtions when using AIS transponder VDO sentences (FS#458)
140. Correct rendering of Lat/Lon Grid lines for certain zoom levels.
141. Convert Toolbox→PlugIns tab to scrolled window. (FS#504)
142. Correct logic for “Max Detail Here” with PlugIn chart types.
143. Move UserIcons to {PrivateDataDir} (FS#497)
144. Correct Dashboard toolbar icon initial state.
145. Correct Toolbar positioning logic with Dashboard activated.
146. Correct mouse right click logic to always allow tide/current selection (FS#500)
147. Implement memory management scheme (FS#469)
148. Implement improved Layers management patch (FS#507)
149. Implement configurable navobj.xml backup scheme. Thanks Pavel. “KeepNavobjBackups”
150. Implement Dashboard Clock. Thanks again, Pavel.
151. Implement VMG display on route follow console. (FS#171) One more for Pavel
152. Add Hungarian language support.
153. Update Tide/Current database. Thanks Happy Seagull (Pat) and Thomas.
154. Improve Toolbox→Charts visitation logic (FS#510)
155. Correct Chinese (Taiwan) language selection option (FS#512) (FS#473)
156. Correct logfile timestamp format and start date. (FS#511)
157. Correct occasional crash on Track Delete from context menu, (FS#514)
158. Correct NMEA data port selection “None” logic (FS#513)
159. Add command line parameter framework and unit_test option

http://www.cruisersforum.com/forums/tags/autopilot.html
http://www.cruisersforum.com/forums/tags/nmea.html
http://www.cruisersforum.com/forums/tags/route.html
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Notes:

137. In anticipation of rework of NMEA message handling modules, we add a new config string.
If you need RMC output on your autopilot port, add the following config string:

[Settings]
AutoPilot NMEA Sentence Out=RMB;RMC

Default is RMB only, and works for most autopilots.
Most users will not need this config entry.

143. Simply copy your existing UserIcons folder to the same location that contains the OCPN config file.

147. Simple memory management scheme, for use with limited resource systems.
There are two modes, only one of which can be active. Specified in config file.

a. Application memory limit target. Try to limit the total memory used by OCPN to the specified value,
approximately. Specify this mode by:

[Settings]
MEMCacheLimit=xxx

where xxx is memory use target in Mbytes. Overrides NCacheLimit below.

–or–
b. Open chart limit. This is the default mode under linux, and the default value is 20 open charts at any
one time.
Modify this limit by the following:

[Settings]
NCacheLimit=y

where y is the maximum number of simultaneously open charts.

If you do not enter any memory management specification in the config file, the following defaults apply:
a. Linux… behavior is the same as previous versions, Open chart limit is 20 charts.
b. Windows…Application memory limit target is used. Target limit is 50% of available physical RAM.

149. Specified in config file.
[Settings]
KeepNavobjBackups=n

150. Peter will like this one
152. Welcome aboard Hungary!
159. This is new. The first ( and currently only) OpenCPN command line parameter has been added.
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Try (from a command line interface) opencpn -unit_test_1.
This test cycles thru all possible charts in the currently loaded chart database, adjusting the viewport to
show the loaded chart automatically. The value of this test is clear: it provide an unattended stress test
of OpenCPN, It is most fun to watch in quilt mode…..
The test runs until all charts in the database have been visited once.
I don't plan to document this test in normal user documentation. Lets think of this as a Beta test tool.

A couple of special requests:
1. Especially for Windows users: If you experience «ANY» hickup on installation, please save your log file
and config file before wiping and re-installing. We need them to anayze install/upgrade issues. Once they
are gone, they are gone.

2. Again, windows users: If you have the time, it would be useful to re-install 2.3.1 from the .org site,
work with it a bit to create a unique config file, and then try to install this Beta as though you were a
casual user, and not a highly experienced and resourceful Beta tester. Note all head scratches and
wrinkles, so we can iron them out.

3. Similarly, complete installs from scratch (i.e. remove previous versions entirely by hand if necessary)
should be tested carefully.

4. linux source builders: build/compile warning logs are solicited. Most of the compiler warnings are
informative, to me at least.

Plan:

This Beta should be considered functionally complete and frozen for Release 2.5.
There will be one more chance to update Language files in the next week or so, and I will then post the
2.5 Release Candidate (RC) for an extended test.

If you have been monitoring the sourceforge download stats, you will note that there are many
thousands of copies of OpenCPN 2.3.1 in the field. Who knows how many are being used, but….
We must be very critical of installation bugs and obtuse operational corner cases before we release 2.5

Thanks for all your diligent efforts.

Good Luck
Dave ====== ====== Ahoy There, OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 611 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog:

http://www.cruisersforum.com/forums/tags/logs.html
http://www.cruisersforum.com/forums/tags/opencpn.html
http://www.cruisersforum.com/forums/tags/opencpn.html
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160. Correct CM93 quilted COG-Up auto-follow rendering
161. Add some missing translation strings to RouteProps
162. Move Layers directory to {PrivateDataDir}
163. Two small patches to Layers logic (FS#507)
164. Correct unintentional chart shift on Toolbar orientation toggle (FS#486)
165. Improve Toolbar Tooltip positioning logic
166. Correct sometimes crash on OCPN exit with AISTargetList open. (FS#517)
167. Correct another sometimes crash on Track delete (FS#507)
168. Improve GPS Status Window positioning logic (FS#516)
169. Correct console BRG formatting for >= 359.5 (FS#519)

Notes:

160. Note the added UpdatePeriod field in Toolbox→GPS. This period relates to how often the entire
ViewPort (i.e. the displayed chart) is updated. The ownship and AIS icons are updated every second, as
usual.

Language files:
One more chance to update language files for the 2.5 Release. There is at least one new string in 611
that needs to be translated.

All possible smoke tests encouraged….

Thanks to all for your testing efforts. We will soon be able to take a breather, and think bigger
thoughts….

Good Luck
Dave ====== ====== Ahoy (again), OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 612 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog
170. Correct cm93 Longitude 0 Viewport calculation
171. Add some translate strings in ais.cpp
172. Small conditional touchups for Mac build

Release Beta 2.4.612

Notes:

172. I will soon have some news/instructions for a workable Mac build of 2.4.612. Please stand by.
How many Mac capable Beta testers do we have? Any?

http://www.cruisersforum.com/forums/tags/gps.html
http://www.cruisersforum.com/forums/tags/ais.html
http://www.cruisersforum.com/forums/tags/opencpn.html
http://www.cruisersforum.com/forums/tags/opencpn.html
http://www.cruisersforum.com/forums/tags/monitor.html
http://www.cruisersforum.com/forums/tags/ais.html
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Sorry for the 611 glitch
Good Luck

Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 620 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

Source is available now on sourceforge git repo.

Changelog

173. Correct Windows USB GPS hotplug stall.(FS#529)
174. Correct extreme overzoom cm93 course-up mode rendering.
175. Correct Dashboard Toolbar tool toggle state on Dashboard close.
176. Correct Navigation console positioning logic (FS#531)(FS#522)(FS#541)
177. Improve S57Query Dialog layout (FS#527)
178. Correct AIS Brg formatting (FS#533)
179. Correct VMG display for invalid COG (FS#532)
180. Correct shift '-' key zoomout (FS#535)
181. Correct Mark drag, route create, and Measure tool when over toolbar (FS#530)
182. Improve logic for chart db cacheing
183. Correct AIS CPA calculation for COG=na from VDO sentences (FS#543)
185. Numerous changes for Mac build
186. Update S52 symbol rules.

Release Beta 2.4.620

Notes:

185. We are finally getting the Mac build caught up to the modern Beta process. Mac builders take note.
Please surf on over to the Mac thread for more info.

Release status:

There were too many changes in this Beta to consider it a Release Candidate, so we continue Beta
testing.
I'm off to sea for a few days, so I'll look forward to lots of new bugs on my return 

Good Luck
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 628 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

http://www.cruisersforum.com/forums/tags/opencpn.html
http://www.cruisersforum.com/forums/tags/opencpn.html
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http://www.cruisersforum.com/forums/tags/navigation.html
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Source is available now on sourceforge git repo.

Changelog

187. Correct ownship anchored TCPA logic (FS#543)
188. Correct Dashboard dragging/docking anomaly (FS#548)
189. Correct Toolbar orientation toggle on GTK (FS#553)
190. Work-around yet another undocumented behavior of GPSD….sigh…(FS#435)
191. Redesign “Donate” button in Toolbar→Help to avoid copyright problems.
192. Improve quilt logic to allow quilting by chart family (FS#560)
193. Remove context menu item “Move Boat Here” if GPS signal is valid (FS#559)
194. On MOB, do not create return route if GPS COG is invalid. (FS#554)
195. Improve format of Chart info rollover window (FS#556)
196. Implement timeout for AIS target rollover window(FS#554)
197. Correct lost AIS target deletion with target list dialog open (FS#552)
198. Modify Windows installer License page. (FS#561)
199. Correct Route behavior near IDL (FS#563)
200. Correct occasional problem with GPS status box indicator (FS#546)
201. Move linux plugin location to {prefix}/lib/opencpn
202. Numerous Mac build and runtime corrections, including PlugIns and GPSD support.

Release Beta 2.4.628

Notes:
202. Changes made for Mac build which may have unintended side effects for other platforms should be
tested thoroughly. They include:
a. Locale (language) changes.
b. GPSD

Mac users may jump on over to the Mac thread for more info.

Open Issues:
a. Bobofthenorth disappearing Routes…..
b. Cagney's Route Extend difficulties….

Other than these two issues, I think we are getting really close to releasing 2.5.

Attention: Last call for localization files (.po)…..

Good Luck
Dave ====== ====== hoy, OpenCPN'ers…

OpenCPN Version 2.4 Beta Build 708 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version…..

http://www.cruisersforum.com/forums/tags/copyright.html
http://www.cruisersforum.com/forums/tags/family.html
http://www.cruisersforum.com/forums/tags/gps.html
http://www.cruisersforum.com/forums/tags/mob.html
http://www.cruisersforum.com/forums/tags/route.html
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http://www.cruisersforum.com/forums/tags/ais.html
http://www.cruisersforum.com/forums/tags/lost.html
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http://www.cruisersforum.com/forums/tags/monitor.html
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Source is available now on sourceforge git repo.

Changelog

203. Correct Dashboard Sunset time calculation.
204. Correct Route Extend logic
205. Correct AIS Toolbar icon update logic (FS#567)
206. Improve AIS Alert dialog font selection (FS#570)
207. Improve CMakeLists.txt for arch and distro type.
208. Improve NMEA error condition management(FS#555)
209. Correct Route/Track drawing logic
210. Documentation files update. Thanks to Thomas (cagney)
211. Correct for lost focus on Windows after clicking e.g AIS target list.
212. Correct for orphan AIS target in AIS target list (FS#552)
213. Correct location of “Overzoom” indicator (FS#572)
214. Implement persistence of S57 Query dialog size.
215. Correct screen refresh logic (FS#571)
216. Correct GPX Export file overwrite logic (FS#575)
217. Various Mac usability updates.
218. Update S52 symbology.
219. Implement Multi-leg measure tool
220. Implement PlugIn accessible chart database support.

Release Beta 2.4.708

Notes:

210. Lots of work on the Wiki. A snapshot of the current state was used to create the embedded help
files. Please take a close look at the embedded help. Special thanks to Thomas (cagney).

219. By popular request….

220. This will allow a future chart updater PlugIn to work smoothly in the backgound.

Getting close now. I am working on a few last minute Flyspray items.
I really want to get this Release out in the next few days. There comes a time when it is done…..

Thanks
Dave ====== ====== Beta Test Team….

Well, we did it! 2.5 has launched, and is safely in orbit.

It goes without saying (but I'll say it anyway) that we could not have produced such a robust and reliable
Release without the patience, tenacity, and broad knowledge base of our Beta Test Team. You should all
be proud. I know I am.

Well done. I thank you all. 

http://www.cruisersforum.com/forums/tags/route.html
http://www.cruisersforum.com/forums/tags/ais.html
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http://www.cruisersforum.com/forums/tags/screen.html
http://www.cruisersforum.com/forums/tags/current.html
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Special thanks go to the PlugIn developers. I think we have proved the concept with this Release, and
look forward to more PlugIn extensions as we go forward.

I could go on and on with kudos, but I'll stop here. You know who you are, and what you did. Be proud.

What's next?
I'll take a bit of a breather, and then we should start some higher level discussion regarding a roadmap
for the future. Several of the team have indicated to me that they have ideas in that direction, and now is
the time to make some plans. Lets all step back one pace and look a bit farther out….

By all means, let it be known that we are not done yet. There is a universe of blank bits out there, just

waiting for a chance to be useful.

My heartfelt thanks to all.
Dave ====== ====== Hello Beta Testers…

The OpenCPN Beta Test Program for 2.6.xxxx leading to the next Release is just about ready to startup.

One thing remains: As you may surmise, I am cruising full time and am chronically short of internet
bandwidth.
So, we need a volunteer to assist in building and uploading the Windows version of OCPN 2.6.
Volunteer should have good internet connection, some experience with Microsoft Visual studio, and a big
heart. The time commitment is not large, but is periodic. If our previous experience is a guide, we can
expect a new Beta release every two weeks, or so.

Let me know if you can help.
Thanks
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.6 Release Candidate 1125 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version binaries…..

Source is available now on sourceforge git repo.

Changelog

1. Implement Smooth Zoom/Pan option.
2. Implement OpenGL option.
3. Correct application startup position algorithm for Windows (FS#591)(FS#627)
4. Correct quilted chart selection logic for “RemoveChartFromQuilt” (FS#609)
5. Correct FullScreenQuilt enable/disable logic. (FS#608)
6. Change “North Up” context menu entry to “Chart Up” for skewed raster charts.
7. Add notation of config file location to Toolbar→Help
8. Improve AIS target removal logic (FS#588)

http://www.cruisersforum.com/forums/tags/concept.html
http://www.cruisersforum.com/forums/tags/opencpn.html
http://www.cruisersforum.com/forums/tags/internet.html
http://www.cruisersforum.com/forums/tags/internet.html
http://www.cruisersforum.com/forums/tags/monitor.html
http://www.cruisersforum.com/forums/tags/charts.html
http://www.cruisersforum.com/forums/tags/ais.html
http://www.cruisersforum.com/forums/tags/removal.html
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9. Correct PlugIn chart type initialization logic.
10. Improve NavObj file backup logic to eliminate invalid (FileNotFound) errors.
11. Implement application portability option (-p)
12. Document/update library dependencies to allow sound support for Ubuntu 11.04+ (FS#607)
13. Correct Drop Waypoint by CTRL-M for navobj persistence. (FS#652) Thanks David Tischler!
14. Correct mouse behaviour on Tide/Current window graph (FS#640)
15. Correct Console BRG report field for legs crossing IDL (FS#620)
16. Correct Route/Track delete and update logic (FS#658) Thanks PjotrC
17. Improve cm93 Chart InfoBox “Name” field in single chart mode. (FS#359)
18. Correct behavior on reported AIS Target Lat/Lon “unavailable” (FS#651)
19. Correctly show waypoints with both symbol=“empty”, and non-empty Name. (FS#612)
20. Correct AIS logic to show Brg=n/a if Range=0.0 (FS#637)
21. Correct TTG/ETA display logic when VMG<0.0 (FS#636)
22. Correct Waypoint edit logic relating to associated route segments(FS#648)
23. Improve GRIB and AIS Target List dialog positioning limits (FS#628)(FS#578)
24. Correct georeferencing for skewed polyconic charts in NorthUp mode (FS#600)
25. Improve sound effects behavior on anchor watch alarm (FS#607)
26. Implement preload of S57 Object Class list prior to initial vector chart load.
27. Correct Toolbar visibility on route create (FS#649)
28. Correct AIS target list sorting algorithm (FS#597)
29. Improve Route/Waypoint add logic (FS#626) Thanks ptizef!
30. Improve daily and import track naming logic (FS#633) Thanks pjotrc
31. Correct Windows HTML Hyperlink load to embedded anchor point. (FS#646)
32. Upgrade to wxWidgets 2.8.12
33. Shift to Microsoft VS2010 for Windows builds
34. Correct chart file update time checking logic (FS#623)
35. Correct Dutch ENC chart rendering (FS#586)
36. Correct Tide column title for Unicode (FS#662) Thanks pjotrc!
37. Optimize track storage in navobj.xml
No GUIDs, point names, symbols, types or opencpn extension attributes on track points
No point timestamps on imported tracks, unless present in import GPX file
38. Optimize Track Properties dialog for improved performance.
39. Add “libsdl1.2debian” as a necessary dependency for .deb packages (FS#603)
40. Correct GPX path memorization logic (FS#625) Thanks ptizef
41. Correct RouteManagerDialog sorting logic (FS#629) Thanks ptizef
42. Apply patch to save layer visibility state (FS#635) Thanks pjotrc
43. Improve AnchorWatch functionality (FS#634) Thanks pjotrc
44. Implement IENC2.0 Overlay cell type rendering. (FS#604)
45. Correct Windows comm port setup for Bluetooth connections (FS#381)

Notes:
2. OpenGL
This will be a significant upgrade for some users of OpenCPN. It is selectable in Toolbox, according to
user preference and system capability.

Here is what I have found:
-Performance with even simple low-cost accelerated graphics cards is much improved for some
operations, particularly chart rotations and local panning.

http://www.cruisersforum.com/forums/tags/single.html
http://www.cruisersforum.com/forums/tags/ais.html
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-Performance may not be improved with embedded graphics chips as often found in older laptops and
netbooks.
-The implementation is not complete for vector charts. Some features may render incorrectly,
or not at all. This is an area of continuing development.
-We can get better “eye candy”, such as smooth zoom and pan, with little impact on responsiveness.

So, user's choice. If OpenGL works better for you, then use it. If not, the present DC based graphics
render system is still in place, with performance equivalent to Version 2.5.0
I invite comments on OpenGL performance and compatibility.
3. Especially needs testing with MultiMonitor setups on Windows and linux.
7. By popular request, will help in Forum debugging.
11. Implement Portability option:
Here is how this works in Windows….

The following files/directories/folders must be in the directory containing the OpenCPN executable:

1. OpenCPN.exe (of course)
2. “opencpn portable.bat ” (or other name of user choice)
A MSDOS batch file containing the one line:
“opencpn -p”
3. msvcr100.dll
4. msvcp100.dll
5. Seven wxWidgets dlls
6. OCPN data directories
plugins/
s57data/
share/
sounds/
tcdata/
wvsdata/
doc/
7. license.txt

To run OpenCPN portably within this directory, simply execute the “opencpn portable” batch file. There
may be a way to build a clickable shortcut to OpenCPN, with the -p option specified in the shortcut. But I
could not figure it out. Windows insists upon a drive letter in the command line of the shortcut, which
would defeat the whole purpose of portability.
Thus, the batch file….
I find that this works pretty well from a USB stick…

On linux, a similar functionality exists.
Copy the opencpn executable binary and the data directories mentioned above to a local directory.
In that directory, do
$ ./opencpn -p
This will cause all user data files to be created and used from within that local directory.
This can be useful for side-by-side testing…

http://www.cruisersforum.com/forums/tags/linux.html
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31. HTML Hyperlinks with embedded anchors requires testing with firefox on Windows….
32. A bit disruptive, but allows simpler access to runtime dlls, also needed for “portable” option.
34. Added “Scan Charts and Update Database checkbox to Toolbox→Charts.
Use this option if you have made any changes to the contents of your chart directories, as for example
after downloading new charts from NOAA, etc.
Need not be checked if directories are added or subtracted, as the entire database will be scanned and
updated automatically in this case.
35. Dutch ENC logic correction…
If this applies to you, you will need to delete and rebuild the SENC files relating to the Dutch ENCs in
order to capture the new code effects.
37. Improved track management.
I took the liberty of simplifying the GPX/XML storage format of tracks. This makes a big difference in
performance for large tracks.
Now would be a good time for interested parties to comment on the need for recording extended
properties and GUIDs for tracks. I can think of no real reason to retain these properties, other than a
satisfying symmetry with Routes…
44. Only known to appear on Austrian IENC cells. Others seen?
45. Tested on simulated environment. Feedback appreciated. Well, there it is. A big list, but really only a
few highly visible fixes and upgrades.
We are working toward a Release of Version 2.7.0, possibly around the beginning of Jan, 2012.

As you may note, there are literally hundreds of Feature Requests being quietly ignored, so far.
More tester input is needed regarding which Feature Requests will impact the most users with the least
effort….

Please remember to clear your Flyspray bugs if able, or at least annotate them for developer study…

Thanks
Dave ====== ====== Ahoy, OpenCPN'ers…
OpenCPN Version 2.4 Release Candidate 720 will soon be available for download from opencpn.org .
Monitor the opencpn.org Downloads page to find and download the latest Beta version…..
Source is available now on sourceforge git repo.

Changelog
234. Two small corrections for Fedora compiler errors.
235. Correct for occasional crash on cm93 zoomin.
246. Improve GRIB PlugIn to show isobars. Thanks rooiedirk 
247. Correct Measure tool logic (FS#590)

Release RC 2.4.720

Well, folks, this is it. One more round of smoke testing, and we'll call it good.
The only change I plan to still make is upgrading the Version number from 2.4.720 to 2.5.0. That's it!

Here is a Preview of the “official” Release notes. Please feel free to edit, amplify, or comment as desired,
and send me the results.

New or Enhanced features in OpenCPN Version 2.5
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1. Per-Cell offset adjustment for cm93 charts
2. Transverse Mercator chart quilting.
3. Selectable full screen quilting option.
4. Configurable lat/lon gid lines.
5. Variable screen dimmer function.
6. Improved Tide/Current information window.
7. Configurable “Layers” function, enabling selectable display of fixed objects.
8. Improved and extended AIS functions, including
a. Euro Inland support
b. Base Stations and ATONs
9. Selectable FullScreen display mode.
10. Integrated Route Planner function, with Tide table support.
11. Enhanced GUI functions, with floating transparent Toolbar.
12. Several new language options.
13. Improved internal memory management.
14. Improved Autopilot output support.
15. New Multi-leg Measurement tool.
16. Improved Vector chart symbology.
17. Improved integrated Tide/Current data accuracy.
18. Greatly improved staility on all platforms, as a result of extended Beta testing.

PlugIns:
1. Enhanced Dashboard PlugIn with several new instruments.
2. Enhanced GRIB PlugIn with isobar graphic depiction.

Thanks Again
Dave ====== ====== Beta Test Team….

Well, we did it! 2.5 has launched, and is safely in orbit.

It goes without saying (but I'll say it anyway) that we could not have produced such a robust and reliable
Release without the patience, tenacity, and broad knowledge base of our Beta Test Team. You should all
be proud. I know I am.

Well done. I thank you all. 

Special thanks go to the PlugIn developers. I think we have proved the concept with this Release, and
look forward to more PlugIn extensions as we go forward.

I could go on and on with kudos, but I'll stop here. You know who you are, and what you did. Be proud.

What's next?
I'll take a bit of a breather, and then we should start some higher level discussion regarding a roadmap
for the future. Several of the team have indicated to me that they have ideas in that direction, and now is
the time to make some plans. Lets all step back one pace and look a bit farther out….
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By all means, let it be known that we are not done yet. There is a universe of blank bits out there, just

waiting for a chance to be useful.

My heartfelt thanks to all.
Dave ====== ====== Hello Beta Testers…

The OpenCPN Beta Test Program for 2.6.xxxx leading to the next Release is just about ready to startup.

One thing remains: As you may surmise, I am cruising full time and am chronically short of internet
bandwidth.
So, we need a volunteer to assist in building and uploading the Windows version of OCPN 2.6.
Volunteer should have good internet connection, some experience with Microsoft Visual studio, and a big
heart. The time commitment is not large, but is periodic. If our previous experience is a guide, we can
expect a new Beta release every two weeks, or so.

Let me know if you can help.
Thanks
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.6 Release Candidate 1125 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version binaries…..

Source is available now on sourceforge git repo.

Changelog

1. Implement Smooth Zoom/Pan option.
2. Implement OpenGL option.
3. Correct application startup position algorithm for Windows (FS#591)(FS#627)
4. Correct quilted chart selection logic for “RemoveChartFromQuilt” (FS#609)
5. Correct FullScreenQuilt enable/disable logic. (FS#608)
6. Change “North Up” context menu entry to “Chart Up” for skewed raster charts.
7. Add notation of config file location to Toolbar→Help
8. Improve AIS target removal logic (FS#588)
9. Correct PlugIn chart type initialization logic.
10. Improve NavObj file backup logic to eliminate invalid (FileNotFound) errors.
11. Implement application portability option (-p)
12. Document/update library dependencies to allow sound support for Ubuntu 11.04+ (FS#607)
13. Correct Drop Waypoint by CTRL-M for navobj persistence. (FS#652) Thanks David Tischler!
14. Correct mouse behaviour on Tide/Current window graph (FS#640)
15. Correct Console BRG report field for legs crossing IDL (FS#620)
16. Correct Route/Track delete and update logic (FS#658) Thanks PjotrC
17. Improve cm93 Chart InfoBox “Name” field in single chart mode. (FS#359)
18. Correct behavior on reported AIS Target Lat/Lon “unavailable” (FS#651)
19. Correctly show waypoints with both symbol=“empty”, and non-empty Name. (FS#612)
20. Correct AIS logic to show Brg=n/a if Range=0.0 (FS#637)
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21. Correct TTG/ETA display logic when VMG<0.0 (FS#636)
22. Correct Waypoint edit logic relating to associated route segments(FS#648)
23. Improve GRIB and AIS Target List dialog positioning limits (FS#628)(FS#578)
24. Correct georeferencing for skewed polyconic charts in NorthUp mode (FS#600)
25. Improve sound effects behavior on anchor watch alarm (FS#607)
26. Implement preload of S57 Object Class list prior to initial vector chart load.
27. Correct Toolbar visibility on route create (FS#649)
28. Correct AIS target list sorting algorithm (FS#597)
29. Improve Route/Waypoint add logic (FS#626) Thanks ptizef!
30. Improve daily and import track naming logic (FS#633) Thanks pjotrc
31. Correct Windows HTML Hyperlink load to embedded anchor point. (FS#646)
32. Upgrade to wxWidgets 2.8.12
33. Shift to Microsoft VS2010 for Windows builds
34. Correct chart file update time checking logic (FS#623)
35. Correct Dutch ENC chart rendering (FS#586)
36. Correct Tide column title for Unicode (FS#662) Thanks pjotrc!
37. Optimize track storage in navobj.xml
No GUIDs, point names, symbols, types or opencpn extension attributes on track points
No point timestamps on imported tracks, unless present in import GPX file
38. Optimize Track Properties dialog for improved performance.
39. Add “libsdl1.2debian” as a necessary dependency for .deb packages (FS#603)
40. Correct GPX path memorization logic (FS#625) Thanks ptizef
41. Correct RouteManagerDialog sorting logic (FS#629) Thanks ptizef
42. Apply patch to save layer visibility state (FS#635) Thanks pjotrc
43. Improve AnchorWatch functionality (FS#634) Thanks pjotrc
44. Implement IENC2.0 Overlay cell type rendering. (FS#604)
45. Correct Windows comm port setup for Bluetooth connections (FS#381)

Notes:

2. OpenGL
This will be a significant upgrade for some users of OpenCPN. It is selectable in Toolbox, according to
user preference and system capability.

Here is what I have found:
-Performance with even simple low-cost accelerated graphics cards is much improved for some
operations, particularly chart rotations and local panning.
-Performance may not be improved with embedded graphics chips as often found in older laptops and
netbooks.
-The implementation is not complete for vector charts. Some features may render incorrectly,
or not at all. This is an area of continuing development.
-We can get better “eye candy”, such as smooth zoom and pan, with little impact on responsiveness.

So, user's choice. If OpenGL works better for you, then use it. If not, the present DC based graphics
render system is still in place, with performance equivalent to Version 2.5.0
I invite comments on OpenGL performance and compatibility.
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3. Especially needs testing with MultiMonitor setups on Windows and linux.
7. By popular request, will help in Forum debugging.
11. Implement Portability option:
Here is how this works in Windows….

The following files/directories/folders must be in the directory containing the OpenCPN executable:

1. OpenCPN.exe (of course)
2. “opencpn portable.bat ” (or other name of user choice)
A MSDOS batch file containing the one line:
“opencpn -p”
3. msvcr100.dll
4. msvcp100.dll
5. Seven wxWidgets dlls
6. OCPN data directories
plugins/
s57data/
share/
sounds/
tcdata/
wvsdata/
doc/
7. license.txt

To run OpenCPN portably within this directory, simply execute the “opencpn portable” batch file. There
may be a way to build a clickable shortcut to OpenCPN, with the -p option specified in the shortcut. But I
could not figure it out. Windows insists upon a drive letter in the command line of the shortcut, which
would defeat the whole purpose of portability.
Thus, the batch file….
I find that this works pretty well from a USB stick…

On linux, a similar functionality exists.
Copy the opencpn executable binary and the data directories mentioned above to a local directory.
In that directory, do
$ ./opencpn -p
This will cause all user data files to be created and used from within that local directory.
This can be useful for side-by-side testing…

31. HTML Hyperlinks with embedded anchors requires testing with firefox on Windows….
32. A bit disruptive, but allows simpler access to runtime dlls, also needed for “portable” option.
34. Added “Scan Charts and Update Database checkbox to Toolbox→Charts.
Use this option if you have made any changes to the contents of your chart directories, as for example
after downloading new charts from NOAA, etc.
Need not be checked if directories are added or subtracted, as the entire database will be scanned and
updated automatically in this case.
35. Dutch ENC logic correction…
If this applies to you, you will need to delete and rebuild the SENC files relating to the Dutch ENCs in
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order to capture the new code effects.
37. Improved track management.
I took the liberty of simplifying the GPX/XML storage format of tracks. This makes a big difference in
performance for large tracks.
Now would be a good time for interested parties to comment on the need for recording extended
properties and GUIDs for tracks. I can think of no real reason to retain these properties, other than a
satisfying symmetry with Routes…
44. Only known to appear on Austrian IENC cells. Others seen?
45. Tested on simulated environment. Feedback appreciated.

Well, there it is. A big list, but really only a few highly visible fixes and upgrades.
We are working toward a Release of Version 2.7.0, possibly around the beginning of Jan, 2012.

As you may note, there are literally hundreds of Feature Requests being quietly ignored, so far.
More tester input is needed regarding which Feature Requests will impact the most users with the least
effort….

Please remember to clear your Flyspray bugs if able, or at least annotate them for developer study…

Thanks
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.6 Beta Build 1210 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version binaries…..

Source is available now on sourceforge git repo.

Changelog
46. Correct S57 Reader for some poorly formed ENCs, esp. Dutch (FS#586)
47. Correct Vector chart NODTA area render logic.
48. Implement OpenGL vector chart “LIGHTS” feature rendering, etc.
49. Correct s57/cm93 render region logic. (FS#666)
50. Improve Route leg rollover message. Thanks Carsten Borchardt!
51. Defensively protect against lost zoom timer events.
52. Correct RouteSplit logic (FS#669)
53. Correct OpenGL partial screen refresh logic, esp. on Vista
54. Correct for waypoint hyperlinks with embedded space characters (FS#671)
55. Correct initial OpenGL vector chart text renderer state logic (FS#664)
56. Improve AIS logic for targets losing position info. (FS#673)(FS#651)
57. Correct AISTargetList positioning logic for Windows (FS#578)
58. Correct AIS TargetQuery Brg report if Range=0.0 (FS#637)
59. Update embedded tinyxml to Version 2.6.2.
60. Implement OFSPRD Feature type in cm93 (FS#650)
61. Improve OpenGL BSB chart texture cache management.
62. Correct Tide/Current manager for some Unicode station names (FS#639) Thanks PjotrC
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63. Implement support for GPSD Version 2.96 with libgps.20.so (FS#595) Thanks Brendan Le Foll

Release 2.6.1210

Notes:

Please remember to clear your Flyspray bugs if able, or at least annotate them for developer study…

Thanks
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.6 Beta Build 1215 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version binaries…..

Source is available now on sourceforge git repo.

Changelog

64. Correct vector chart feature class config file state.
65. Correct GPSD 2.95 interface.
66. Implement S57 Overlay cell rendering for OpenGL (FS#604)
67. Allow S57 object query dialog to close with “X”
68. Correct transparent rendering of AnchorWatch circle.
69. Improve AIS lost target logic (FS#651) Thanks Marco…really…
70. Correct Ctrl-Space (add MOB) (FS#675)
71. Correct OpenGL render cache logic in course-up mode. (FS#677)
72. Correct inital window position logic for GRIB and Dashboard (FS#578)
72. Implement AIS AtoN rendering according to 2008 IMO standards (FS#672)
73. Add Galician (gl_ES) and Catalan (ca_ES) language support.
74. Experimental fix for screen refresh after dialog close (FS#678)
75. Tracking: On timed tracking, allow trackpoints with 2 metre resolution.
76. Add toolbox→Etc option for Track highlighting.

Release 2.6.1215

Notes:
69. AIS targets reporting position unavailable will be rendered in grey colour.
72. Untested in multiple monitor setups on Windows. Marco?
74. Cannot reproduce the error with my hardware. If this fix works for “Jump to Position” dialog, then we
understand the issue a bit better.
75/76. Should allow more useful anchor watch tracking.

General Note….
We are having a lot of trouble with OpenGL on Vista and W7.
We are not alone in this problem, according to Google.
MS implemented a new screen compositing model for Vista and later, which “broke” many OpenGL apps.
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OpenGL users reporting problems are asked to please report the log entries describing the OpenGL
configuration.
e.g.
22:52:53 EST: OpenGL→ Renderer String: Mesa DRI Intel(R) 945G 20061017 x86/MMX/SSE2
22:52:53 EST: OpenGL→ Detected potential i945G renderer bug, disabling stencil buffer
22:52:53 EST: OpenGL→ Framebuffer Objects unavailable
22:52:53 EST: OpenGL→ Using Depth buffer clipping
22:52:53 EST: OpenGL→ Estimated Max Resident Textures: 24

This will help us to reproduce the problem more quickly, if possible.

Please remember to clear your Flyspray bugs if able, or at least annotate them for developer study…

Thanks
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.6 Beta Build 1227 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version binaries…..

Source is available now on sourceforge git repo.

Changelog

89. Correct CTRL +/- zoom behavior.
90. Correct GRIB PlugIn rendering (FS#693)
91. Implement rudimentary PlugIn intercom system. Thanks, Pavel
92. Implement enhanced Route/Track rendering options (FS#680) Thanks Pavel
93. Correct detection of AZERTY keyboard on fr_FR systems. (FS#670)
94. Correct Toolbar misplacement after Options dialog on linux systems.
95. Correct CTRL modifier for wheel zoom on linux
96. Improve OpenGL text rendering (FS#666)(FS#664)
97. Disable OpenGL Stencil buffer for Intel graphics chips.(FS#666)
98. Correct AIS target heading rendering when speed is low and scale is small (FS#694)
99. Correct build conditions for 64bit linux systems (FS#689)
100. Correct Chart close/open persistence logic (FS#691)
101. Implement WVS chart rendering for OpenGL

Release 2.6.1227

Notes:

This Beta release has relatively few items. A couple are critical, though, especially the OpenGL/Vista/Intel
bugs that continue to distract. It will be nice to get these swatted, so that we can move on to
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implementing some more FeatureRequests.

91. Required a bump of PlugIn API to 1.06. As a result, existing PlugIns other than Grib and Dashboard
will require external rebuilding.

Please note that I have not included any new language translations in the 2.6 Beta program. Managing
18+ .po file submission every Beta release takes a lot of time, and is better spent elsewhere.
We will come back to language updates as we near production Release this spring.

Don't forget to check and update “Your” Flyspray issues. We have some old ones on there that I think are
long resolved. As usual, I would like to have the original poster request closure of the resolved items,
instead of closing them myself without feedback.

Thanks, and good luck
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.6 Beta Build 1310 will soon be available for download from opencpn.org .

Monitor the opencpn.org Downloads page to find and download the latest Beta version binaries…..

Source is available now on sourceforge git repo.

Changelog

102. Correct minor shutdown memory leakage in Grib and Dashboard PlugIns
103. Improve OpenGL rendering of LIGHTS features.
104. Improve OpenGL text rendering exclusion algorithm (FS#664)
105. Correct AIS ClassB position report logic (FS#703)(FS#704)
106. Correct waypoint selectability on layers import (FS#695)
107. Correct OpenGL single chart rendering (FS#702)
108. Add multi-monitor support for AIS Target Query Dialog (FS#578)
109. Correct AIS TargetQuery ETA Date formatting (FS#706)
110. Improve Ownship rendering logic.
111. Correct non-WGS84 RNC interpretation of DTM parameter. (FS#700)
112. Correct Follow tool button state logic (FS#692)
113. Correct Dashboard display of unknown data values (FS#534)
114. Correct Mac default initial frame location.

Notes

110. This is new. There are several new keys available for the config file.

OwnshipLengthMeters=nn
OwnshipBeamMeters=mm
OwnshipGPSOffsetY=yy
OwnshipGPSOffsetX=xx
OwnshipMinMM=kk
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Here is the new Ownship rendering logic:
1. Default (yacht) icon is used by default. Default length is 12 m.
2. If OwnshipLengthMeters=nn, the default (yacht) icon is scaled accordingly.
3. If OwnshipLengthMeters=nn and OwnshipBeamMeters=mm, then generic scaled ship icon is used.
4. If ownship.xpm icon is found and used, Rule 2 applies. It is assumed that the ownship icon closely fits
the bounding box of the graphic in the length dimension. OwnshipBeamMeters is ignored.
5. The mimimum scaled size of the ownship icon onscreen may be specified by OwnshipMinMM=kk.
In no case will ship icon be smaller than 1 mm on screen. The default is 10 mm.
6. If canvas scale is less than 300,000, then the ship icon is rendered as a red or grey target, according to
IHO recommendation.
7. GPS antenna location offsets may be specified by OwnshipGPSOffsetY=yy and
OwnshipGPSOffsetX=xx.
Y offset is from bow, measured in metres. Default is one half ownship length.
X offset is from ship centerline, positive values to starboard. Default is zero.

BTW, i agree that the large ownship icon is ugly. Artists solicited

Don't forget to check and update “Your” Flyspray issues.

Thanks, and good luck
Dave ====== ====== Ahoy, OpenCPN'ers…

OpenCPN Version 2.6 Beta Build 1511 will soon be available for download from opencpn.org.

Monitor the opencpn.org Downloads page to find and download the latest Beta version binaries…..

Source is available now on sourceforge git repo.

Changelog

115. Correct various cm93 course-up rendering problems
116. Improve linux dimmer function, including Ctrl-G for green/red
117. Correct cm93 composite Depth Unit reporting.
118. Improve Ownship rendering
119. Correct ENC Area Pattern rendering with Depth Buffer clipping.
120. Improve AIS target rendering in OpenGL
121. Complete implmentation of dashed line drawing in OpenGL
122. Implement Chart Groups
123. Upgrade PlugIn API spec to 1.7
124. Improve ownship drawing logic, OwnshipMinMM = -1(default) for exact bitmap
125. Correct license headers for debian repo inclusion (FS#732)
126. Implement improved Waypoint properties dialog. Thanks Pavel!
127. Correct AIS Target Query fault with target ETA present (FS#709)
128. Correct S52/S57 maximum character string size to 512 chars (FS#729) Thanks ChuckSK
129. Correct Logbook entry when COG/SOG are unavailable (FS#721)
130. Correct for some ENC crashes. (FS#720)
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131. Correct DTM parameter decoding for certain SHOM charts (FS#730)
132. Revamp PlugIn architecture again. Of interest to PlugIn developers.
133. Improve DRGARE symbolization
134. Improve Route-to-Track algorithm. Thanks, pjotr
135. Implement DSC and GPS_Gate Buddy rendering from AIS data stream. (FS#331) Thanks, pjotr

Release 2.6.1511

Notes:

116. Experimental. How do monochromatic red or green diplays look at night on your hardware?
122. Chart Groups…A favorite of mine. I now use it all the time, both underway and for testing.
See notes (for Wiki?) below.
124. Revise ownship icon rendering again. With this version, if no value is specified
for OwnshipMinMM, then the exact built-in bitmap will be used, just like the current 2.5 Release.
126. New Waypoint Proerties dialog. Slick!
132. PlugIn Architecture revamp.
This solves the ongoing problem of having to rebuild all the legacy PlugIns whenever an upgrade to the
PlugIn API is desired or required. Should make life a lot easier for users, especially during Beta cycles.
PlugIn Developers take note of new classes defined in ocpn_plugin.h, and adjust your plugins to match.
This should be the last time that static legacy plugins will need to be rebuilt, I hope.
135. Completely untested. I don't have the hardware…..

Don't forget to check and update “Your” Flyspray issues.

I apologize if I missed any patches buried in the Forum. Merging from multiple developer sources
introduces many opportunities for items falling between the cracks.

Big Picture: I would like to plan for an official 2.7.0 Release sometime in May, 2012.
So, if any developers have ideas just waiting for the chance to play, now is the time.

Thanks, and good luck
Dave

Chart Groups:
Chart Groups solve the following problem: You may have many charts loaded in your active database.
Some of them have overlapping coverage at the same scale, so that when quilted the logic does not
know
which of potentially several charts at the same scale to choose from. For example, in the Bahamas we
have
two publishers of charts covering the same areas with radically different presentations. Sometimes we
want to see one set (say planning charts of small scale), and other times we only want navigation charts
of the best
scale possible. Another example: Pilot charts as one Group, normal nav charts as another Group.
Final example: in another universe, NGA charts in one group, standard NOAA RNCs in another (sigh)

The Chart Group function allows us to define multiple Groups, with different chart directories in each
group.

http://www.cruisersforum.com/forums/tags/charts.html
http://www.cruisersforum.com/forums/tags/dsc.html
http://www.cruisersforum.com/forums/tags/hardware.html
http://www.cruisersforum.com/forums/tags/current.html
http://www.cruisersforum.com/forums/tags/rebuild.html
http://www.cruisersforum.com/forums/tags/classes.html
http://www.cruisersforum.com/forums/tags/hardware.html
http://www.cruisersforum.com/forums/tags/charts.html
http://www.cruisersforum.com/forums/tags/Bahamas.html
http://www.cruisersforum.com/forums/tags/navigation.html
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The Group desired for viewing may be selected quickly without adding or deleting charts from the Active
database.

Here is how it works:
In Toolbox→Charts, select “Chart Groups”
You will see two panes. The left pane contains you installed (“Active”) chart directories.
The right pane alows you to create, edit, and delete Groups.
Note that there is always a “Group 0”, which is all “Active” charts. This Group is not editable.
New Groups which you create may have chart directories or individual charts added to them by
selecting the item in the left pane, and touching the “Add–>” button.
You may also remove individual charts and/or directories from within added items by selecting the
desired item in the right pane, and touching ”<–Remove”.
Please note that “removing” an item from the Group does not remove it from your “Active” set. The item
is simply made unavailable when this Group is in use.

Close the Toolbox dialog as normal.

Select the Group you want to currently use by a right-click context menu item called “Chart Groups”.
As you switch Groups the logic tries to select a chart and scale that closely matches the situation
present before the switch. As you may understand, sometimes the fit is not reasonable, so the
resulting view may be surprising.

Finally, if you have no Groups defined, as in the default installation, the operation of OCPN will
be as in 2.5 legacy releases. All installed charts are available always.

Implementation/UI note: The selection of Group to use is not strictly a chart “context” operation, so a
right-click context menu action is not exactly intuitive to me. However, I could not immediately come up
with a Group selection method that does not subtract yet more chart real estate from the screen.
I invite comments on improved UI ideas….

So, there it is. Chart Groups. Have fun! ====== ======
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